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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-LIOIO Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model NY510J-AJO0O | Industrial PC Platform NY-series IPC

Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W519-E1 Model NX-ECC203 NX-ECC201/ECC202/ECC203
EtherCAT® Coupler Unit User’s
Manual

OMRON Z930-E1 Model NX-SLOIOOO NX-sLOOOO/sIOOO/sondd

Model NX-SICIOIOO Safety Control Unit User’s Manual
Model NX-soOOO0O

OMRON W504-E1 Model Sysmac Studio Version 1 Operation
SYSMAC-SE2[1C1] Manual
DT 0014-E - Power PMAC User’s Manual
DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which process data objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in realtime.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

/A WARNING

T C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the Safety CPU Unit and Safety I/O
Units (hereafter referred to as the Slave) attached to OMRON High EtherCAT Coupler Unit
model NX-ECC203 using OMRON Programmable Multi-Axis Controller model
CK3E-UOOO/NY510-AUOO (hereafter referred to as the Controller) and EtherCAT, as well
as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller Model CK3E-LILI0ON
OMRON Programmable Multi-Axis Controller Model NY51C1-ACIC1O]

Industrial Box PC
OMRON EtherCAT Coupler Unit Model NX-ECC203
OMRON Safety CPU Unit Model NX-SL3[J100
OMRON Safety 1/O Units Model NX-SID800
Model NX-SOD400

IE' Precautions for Correct Use

Use model NX-ECC203 Version 1.4 or later for the EtherCAT Coupler Unit.
Models NX-ECC201 and NX-ECC202 cannot be used.
Model NX-ECC203 Version 1.3 cannot be used.

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Model CK3E-I0O

Windows computer Model NX-ECC203
Power PMAC IDE

Acontis EC-Engineer

Sysmac Studio

-._\____ Ethernet EtherCAT _
communications communications
Model NX-SL3500 Model NX-ID3417
Model NX-SID800 Model NX-OD3256
Model NX-SOD400
Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-L1OCIO Ver.2.2
Controller
OMRON EtherCAT Coupler Unit Model NX-ECC203 Ver.1.4
OMRON Safety CPU Unit Model NX-SL3500 Ver.1.0
OMRON Safety Input Unit Model NX-SID800 Ver.1.0
OMRON Safety Output Unit Model NX-SOD400 Ver.1.0
OMRON Ethernet cable (with industrial Model
Ethernet connector) XS5W-T421-L1IMUI-K
OMRON Sysmac Studio SYSMAC-SE2[11[] Ver.1.15
- Windows computer -
DT Power PMAC IDE - Ver.2.2
Acontis Acontis EC-Engineer - Ver.2.4.3

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information

This document describes model CK3E-LILILI] as an example. The same procedures can
apply to model NY51CJ-ACICIC.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller and the Slave are set to factory

default.

I 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting

the Controller with the Slave via EtherCAT.

6.2 EtherCAT Coupler Unit Settings

v
6.2.1 Creation of a New Project
v
6.2.2 Network Configuration Settings
v
6.2.3 I/0 Map Settings
v
6.2.4 Safety I/O Function Settings
v
6.2.5 Creation of Safety Programs
v
6.2.6 Transfer via Connection to the Communications
Coupler Unit
v
6.2.7 Output of Couple 1/O Allocations
v
6.3 Preparation for the Controller Setup
v
6.3.1 Creation of a New Project
v
6.3.2 Initial Settings of the Controller
v
6.4 Installation of ESI Files
v
6.5 EtherCAT Communications Setup
v
6.5.1 Communications Setup for the EtherCAT Master
v

10

Prepare to set the EtherCAT
Coupler Unit.

Prepare the Controller settings.

Install the ESI file for the Slave into
Acontis EC-Engineer.

Set up EtherCAT communications.



6.5.2 Distributed Clock Setup

v

6.5.3 Safety Controller Variable Settings

v

6.5.4 PDO Map Settings

v

6.5.5 Coupler I/O and Variable Allocations

v

6.5.6 Creation of an EtherCAT Network Configuration
File

v

6.6 Controller Settings

\4

6.6.1 EtherCAT Network Configuration Settings

\4

6.6.2 EtherCAT Communications Check

\4

6.6.3 EtherCAT Variables Settings

\4

6.6.4 Writing the User Program

v

6.6.5 Project Data Transfer

Set up the Controller.

11



I 6.2. EtherCAT Coupler Unit Settings

Configure the slave terminal settings for the EtherCAT Coupler Unit.

Prepare a computer with Sysmac Studio installed.

Windows computer
Sysmac Studio

USB Cable

6.2.1. Creation of a New Project

Model NX-SL3500
Model NX-SID800

Model NX-ECC203

=

Model NX-ID3417
Model NX-OD3256

Model NX-SOD400

Connect the coupler to the
computer using a USB cable.

Turn on the power to the
coupler and safety controller.

Start the Sysmac Studio.

* |f the dialog for confirming Syt Sl
access rights appears upon
start-up, select starting of
Sysmac Studio.

Create a project in the Sysmac
Studio.

E7 offline
4 New Project
fa Open Project
Project Properties
Enter Project name and other
items of information.

,—‘.‘,‘Tg Import...

A Online
Select Device & Connect to Device
Select controller for Category.
You can specify any Device
and Version. In this example,

select NJ501-1500 and 1.10.

™ License

Click Create.

>

1= Project Properties

New Project

Type Standard Project

Project name

Author

Comment

] :

-ﬂfj Select Device
Category Controller
Device NJS01

Version 1.10

Create

12



6.2.2. Network Configuration Settings

New Project - new_Controller_0 - Sysmac Studio

1 Double-click EtherCAT under
Configurations and Setup in
the Multiview Explorer. : A

File Edit WView Insert Project Centroller Simulation

4 Go

Multiview Explorer

Select EtherCAT Coupler Unit
NX-ECC203 in the toolbox, and
drag and drop it directly below
the master in the EtherCAT
Configuration Edit tab page.

Right-click NX-ECC203 in the
Multiview Explorer, and select
Coupler Connection (USB)
then Online.

After you have confirmed the
destination of the USB
connection, click the OK button.

New Project - new_Controller_0 - Sysmac Studio

File Edit View Insert Project Controller Simulation Tools Help

l‘.." B @
j* & G @

-1
new_Controller 0 v | l | Master

= I_ll Master

A Configurations and Setup

= Edit

Unit Operation Settings

B4 Data Trac

 Frooerming

¥ i@ POUs

Coupler Connection {USB)

Confirm that the target communications coupler is Nodel : NX-ECH
Do you wish to connect?

03 (E0O1).

oK Cancel

Double-click NX-ECC203 in the
Multiview Explorer to open the
NX-ECC203 edit page.

Right-click in the NX-ECC203
tab page and select Compare
and Merge with Actual Unit
Configuration from the menu.

D New Project - new_Contreller_0 - Sysmac Studic

File Edit View Insert Project Controller Simulation Tools Help

Multiview Explorer ~ . Nedel : NX-ECC203 (E001) x

Unit 0
new_Controller 0 v

44 Configurations and Setup
¥ & EtherCAT

v Show Model/Unit Name

Get Serial Numbers of All NX Units
Compare and Merge with Actual Unit Configuration

Display Production Information

13



5 Cllck Apply Actu al Unlt B Compare and Merge with Actual Unit Configuration
Configuration to apply the Twwo
actual unit configuration.

M Precautions for Correct Use
You can read only the Unit configuration in the Slave Terminal by comparing and merging
with the actual Unit configuration. You cannot read the I/O allocation information, Unit
operation settings, and Unit application data.

6.2.3. 1/0 Map Settings

1 RIght—Clle NX'ECC203 In the |:|New Project - new_Controller_0 - Sysmac Studio
Multiview Explorer, and select - s

Coupler Connection (USB) —
then Offline. new_Controller 0 v ‘ l | iy d _ i

A4 Configurations and Setup ENDO1
L herCA|
MESS e . EDﬂll N1 | Nz 3 —
et Edit

Unit Operation Settings

Compare

0 Check

(3 Progemming

14



2 In the Multiview Explorer, select
Configurations and Setup,
then 1/0 map tab page to open
the 1/0O map pane.

Right-click on NX-ECC203, and
select Create Device Variable
from the menu.

New Project - new_SafetyCPUO - Sysmac Studio

|Fil.§- Edit Wiew Insert Project Controller i i Tools  Help

1 o 1
Y @B @ al|=
| 4 @ @ a =

Multiview Explorer _—
Po Port Description
| I | - ¥ § FtherCAT Netwaork Configuration
E nerca Ma
" Dodel ¥ " NX

¥ JySMaC CITor Jaws

new_Controller 0 v

b4 Cenfigurations and Setup

Observation

Minor Fault

Partial Fault

Major Fault
# NX Unit Registration Stat|
» NX Unit /O Data Active &
¥ - NX-S13500

W Safety CPU Status

Search
v Expand/Collapse All

BounallOpesing Create Device Variable

Program Operating
Program No Fault
Safety Master Conn
¥ NX-SIDE00
¥ Standard Input 1st Woi—

Display Node Location Port

3 From the controller selection box

in the Multiview Explorer, select
the target Safety CPU Unit.

Double-click I/O map to open
the Safety I/O map tab page.

Multiview Explorer

- new_SafetyCPL v

- new_Controller_0

v
» il POUs
p T Data
» B2 Safety Task

4 Right-click on EtherCAT
Network, and select Create
Device Variable from the menu.

D New Project - new_SafetyCPUO - Sysmac Studio

Edit View Insert Project Controller i Tools Help

4 GG
1 4 I O
Multiview Explorer

| RAW | Data Type |
new_SafetyCPL ¥

¥ Safety Inputs
Si00 Legical Value

5i01 Logical Value
Logical Value
Logical Value
Logical Value
Logical Value
Logical Value
Logical Value

[ Frogramming
» i@ POUs
» = Data
> W, Safety Task

Search
v Expand/Collapse All

Create Device Variable 1
Status

Safety Connection Status,

Safety Input Terminal Statc-

Variable

15



6.2.4. Safety I/O Function Settings

1 From the controller selection box
in the Multiview Explorer, select
the target Safety CPU Unit.

Double-click Safety Slave Unit
Parameter Settings under
NX-SID800 of Configurations
and Setup.

MNew Project - new_SafetyCPUD - Sysmac Studio

File Edit WView Insert Project Controller Sir

1 _
Y @ B @
j* @ @ T

Multiview Explorer

L new_SafetyCPUO

b4 Configurations and Setup

v nmunications

A Programming
» il POUs

2 Select Output Single-channel
Semi-conductor from the toolbox
Input device: Semi-conductor
output type, and drag and drop it
on to the input terminal.

3 Double-click Safety Slave Unit
Parameter Settings under
NX-S0400 of Configurations
and Setup.

Maw Project - new_SafetyCPUD - Sysmac Studio

File Edit View Insert Project Controller S
[ - R
¥ @ @ o
1
Multiview Explorer

L new_SafetyCPUD

bl Configurations and Setup

¥ T_# Communications

4 Select Single Channel (without
test pulse) from the toolbox
Output device, and drag and
drop it on to the output terminal.

16



6.2.5. Creation of Safety Programs

1 Registering programs L4 Programming
Y 8 POUs
Right-click Programs under ¥ = Programs
Programming — POUs in the LM
Multiview Explorer, and select L&) Function Blocks
Add — Programs from the » [ Data

menu. > I Safety Task

2 Creating programs

TEST1 SF.CTU Il
Refer to Section 7 Programming e Bo0L FALSE o
TEST3 SAFEINT 1 O
in the Safety Control Unit User’s TEST4 SAFEINT 0 ]
Manual to create safety L. @@ ]
1
programs.
TEST1
SF_CTU

N2 _5i00 Logical Value cu 0| N3 5000 Cutput Value

TEST2 —RESET CvVy- TEST4
TEST3 BV

6.2.6. Transfer via Connection to the Communications Coupler Unit

1 From the controller selection boX g wey project - new_ssfetycpuo - sysmac studi
in the Multiview Explorer, select i ;
a Safety CPU Unit.

v
» @ POUs
» [ Data
» I, Safety Task

2 Select Controller, then Communications Setup | =

Communications Setup from
Select a method to connect to the Safety CPU Unit.

the menu. @ Connect via MJ/NX-series CPU Unit ‘new_Controller_D"

) Connect via Coupler ‘Nodel : NX-ECC203 (E001) : Offline’

Select Connect via Coupler in oK Cancel
the Communications Setup
dialog box, then click the OK
button.




3 Select Controller, then Online
from the menu.

The unit is in online connection
with slave terminals.

New Project - new_SafetyCPUO - Sysmac Studio

File Edit WView Insert Projec§ Controller § Simulation Tools Help

[T - - - Communications Setup...
|y a @ @ i

Online Ctri+W ]

Multiview Explorer

new_SafetyCPUOD

Security

4 From the controller selection box
in the Multiview Explorer, select
a controller.

New Project - new_SafetyCPUD - Sysmac Studio

File Edit WView Insert Project Controller

1 L
W il @O
¥ @ M T

Multiview Explorer

- new_SafetyCPUO

¥ new SafetyCPUO

v ’_. = Lommunications

5 In the edit page for slave
terminals, right-click the
Communications Coupler Unit,
then select Transfer the
Settings from computer to
Communications Coupler.

Click Configuration
information + Unit operation
setting + Unit application data.

New Project - new_Controller_0 - Sysmac Studio

File Edit View Insert Project Controller Simulation Tools Help

oo (v Felit

0 (N: Unit Operation Settings

Offline

Transfer fi upler

Compare

» Configuration information only

Cancel

18



6.2.7. Output of Couple I/O Allocations

1 Select Controller, then Offline
from the menu.

Mew Project - new_Controller_0 - Sysmac Studio

Multiview Explorer

new_Controller 0

Offline ctrl+shife+w |
Synchronization Ctrl+M
Transfer...

2 Double-click EtherCAT under
Configurations and Setup in
the Multiview Explorer.

Right-click on Master, then
select Export All Coupler’s I/0
Allocations.

Coltapse A

Impart Slive Settings and Insert New Slave

Chear All Settings

" Display ESI Library

| Export All Covplers' U Aliocations |

hguiratian Information
Chstrart bn FUS Fle

19



I 6.3. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.3.1. Creation of a New Project

1 Connect the Controller with the
computer via Ethernet cable.

2 Turn on the power to the
Controller.
3 Start Power PMAC IDE.

* If the dialog for confirming
access rights appears upon
start-up, select starting of
Power PMAC IDE.

4 The Communication screen

appears. Specify the IP address | & Deltz Tau Data Systems Inc. Envimnmen. S |
— e ——__ =
of the destination Controller and Communication | I
|

click Connect. ©=: 4] | |
I IPAddress 192.168.0.200 [=]

* The IP address of the Fort =

Protacal 55H
Controller is set to Uzer root
) ., Pazsward 29999988

192.168.0.200" by default. Apply AllContrals True
SelectDevice AtStartup True

* |f necessary, change the
Windows IP address to

“192.168.0.X". IP Address
Set IP Address

Connect [ Last Seszion ] [ Mo Device ]

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

20



5 Power PMAC IDE starts, and is

online to the Controller.

[ Pawer FaC sute (B328) [P

| Ble Eot view profect Puld Debug Tock DeteTau Window Help

PRl e e @ A a9 et L] b Debug  x Ay CRU vl i
F Status i Jog Fubben | 4 Communication Setup
Watch: Onhnell92168.0.20053H] » A%

[ V3-S5 PowerPmac (1 70T
LR | roverimac(tio Device:)|

& 3 C Languoge

- 3 Configuration

- [ Docurnentation

© alog

@ [ PMAC Script Language

| = ol
E e =
&5 ¥ 1K | posrerPmac(No Device:) Profect roper +
EOTEOERE): Euk =l |l oh T
-— = - | T EAE B
T User Buffer 1 -
:E PowerPMAC Communication Setup 5
Device Properties :
.';;;F;:' e e
- || Communication Settings
FO5z o PowerPmac GHERICHALE LR =
G From the File menu, select New
-
then Project. <+ Power PMAC Suite (Administrator)
Edit View Tools Delta Tau Window Help
New P | 5 Project... Ctrl+Shift+N U
Open » | ‘| File... Ctrl+N [up _
I Close Project From Existing Code...
| =5 | Close soluti
n) ose Solution E—
H [ | Save Selected Items  Ctrl+S
| | E 2233567
Save Selected Items As... .25
I @ | saveAll Ctrl+5hift+5 _
Export Template... i)
|| @ | Page Setup...
| & | Pprint... cerl+p P
H Recent Files 4 ;
| Recent Projects »
f Exit
7 Enter a project name and
location, and select OK. L2
Breject trpms: Zerote: nE
FrevmrFrec PrsrrFmucseile sl templite
e Praent Ties
[Fomves PHAL Frigect Termiate
Haree [Criccsaenn
Fokbonbape: | CTiTs0  Crea drectony b ackusan {}
T

21



6.3.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary
data in advance.

In the Terminal pane, type the

$$$*** Command to reset the File Edit View Project Build Debug Tools DeltaTau Window Help
R =" N I - - - b Debug -
ContrO”er to faCtory defaU|t Watch: Online[192.168.0.200:55H] ~ 0 || Position: Onli
send 0" C d R ="
end Oenang Comman esponse
TR spsowoom ssiss
[ |ECAT[D].Enable 1
[ Slave_0_6071_0_Targettorque |stdin:3:2:emr... |
Terminal: Online[192.168.0.200:55H] >3 x pp_disable.
ff3%Kk
L*0
disab
clear
enabl
(5557 ‘

2 From the Tools menu, select
System Setup to start System e O US| Tocke [ DL TR WL
Set 205w e OEEETEEN.

e Up. B Termnal s Postion [T | Fot i

Witk D[ 100 100, 0. 200 NS EY

On | | TaskManasger
Send o 4 Cornm|

| Tune
] ECATIO| 1
” Aktach to P [: +alt4+E
r EcaTj| W | Attach to Process i
EEET D ekl

External Tooks:

Qplions. .,

i

PowerPMAC System Setup starts.

Giobsl Clock Sating

sa00

22



3 From the File menu of
PowerPMAC System Setup, select
New then Setup.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File | Database

-| New > Setup |

Add 3

Save Setup

Restore Setup

4 Specify Servo Frequency. Global Clock Setting

Selt_act the Servo Frequency Phase Frequency 1,000 LHe
setting from 4 kHz, 2 kHz, or
1 kHz. Servo Frequency [T ke

* Servo Frequency is setto 1 kHz
for the example in this document.

Detected Servo Hardveare—FWM Freguency

5 Click the Accept button.

= B ]

9

— Mewe clock  Power PMAC

settings Walkue
Servo Period (msec) 1000 1000
PhaseChirServoPerind 1000 1000

No Master Gate detected and No

ETHERCAT option detected

PowerPMAC can be used asa PC using |_
. software clock. (sys CPUTimerntr= 1) On|

Accepting the clock issue save and 585

in the terminal window for changes to

take effect Check "sys.ServoTime' to

6 If you have changed the servo
frequency setting, type the SAVE
command in the Terminal pane of
Power PMAC IDE.

When complete, the “Save
Complete” message appears in
the Terminal pane.

Terminal: Online[192.168.0.200:55H]

23



7 Click Communication Setup on
the toolbar to display the Device
Properties dialog box.

Brosda .
B Terminal 5 Position [ Watch J8] Status K Jog Ri
| Watch: offiine o x

w HTOEFR(S):

Sl

won || 4 Communication Setup| _

Ya—tmn THRTO-T

& Drvice Properties S

B |
2 Device
].l‘ﬂdche:i

Protncal
User

1P Aaddr iz
Se1 IF Address

=

B

8 In the Device Properties dialog
box, select No Device for IP
Address, then click the Apply
button.

This operation sets the Controller
to the offline state.

& Device Properties ‘

[ Test |

)4l |

El Device
IPAddress
PortMumber
Protocol
LUzer

IPAddress
Set [P Address

-
Mo Device ‘_‘

The Controller restarts.

The servo frequency that has been
set is reflected.

10

Wait until the startup process of
the Controller is complete. Then
click Communication Setup on
the toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the Controller
to the online state.

-
& Device Properties

[ Test |

FortMumber
| Frotocal
Lser

IP Address
Set IP Address

24



I 6.4. Installation of ESI Files

Install the ESI file for the Slave into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer.

£ Power PMAC IDE

b

I'.{,.j‘jl Paint
2o

» Al Programs

| |Search programs and fil

ile

files 2 |
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2 From the File menu of
EC-Engineer, select ESI
Manager.

The ESI Manager appears.

= EC-Engineer [-
m View Network Settings Help

% New Ctri+N
= Open Ctrl+0
H save Cirl+5 _
H saveas
Print

- IrT——

ESI Manager

e e

= Recent Projects 3

Exit Alt+F4

Example of the ESI Manager

[~ ES1 Manager . -— =S
ESI Files
Sefect an ESI file which should be deleted or exported or add new ESI files,

£ Baumueter Nuemberg GrmbH
B Becknoff Automation Gmbk & Co. KG

€@ Copiey Cantrols Comp

.
»
1 3

| » L e
b B OMRON Corporation
Bouns VIPA Genbed
»

¥ vasuawa Dedtric Conporatian

Number of ESI files: 79
l Number of devices: 1630 .
Add Folder

Add File Close

3 Confirm that Omron
NX_Coupler.xml is registered in
the ESI file list of ESI Manager.

If it is not yet registered, click Add

L] [ESSEE==)

= ESE Manager S

ESI Files
Select an E51 file which should be deleted or axported or add new ESI files.

| b G Copley Controls Com.

b Omran G-Digital 10 smi

e

Number of devices: 1925 |

File and register Omron saarie | ssaroiser e
NX_Coupler.xml.

4 Click Close to close the ESI i Add 51 Fie —_—
Manager. Gz« voumens » Satemisiies -] 4y

b el
= Recent Places [ Omron 6X-IC

Fhla? Ghadlakl

Organize = New folder B 0o @
3¢ Favorites Documents library Artangeby: Folder =

M Desktop SystemEsiFiles

8 Downloads Name - -

& Libraries = Omran NX_Coupler i
@ DD(L_JmEntS =] Omron N 7Modu\a-s
& Music [2] Omron RBBD-KNbock-ECT
% 3':““5 = Omron RBBD-KMoo-ECT-L
ideos

|Z| Omron ZW-7
I YT

- m ]

"B Comnuter

1

D

File name: Omron NX_Coupler

- ESI Files (*xml) -
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I 6.5. EtherCAT Communications Setup

Set up EtherCAT communications.

M Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.5.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of
EC-Engineer, and select
EtherCAT Master Unit (Class
A) from Add Master Unit.

|| Classic viw | Flat View

Topology View

od

Start Page

EC = Engineer

Getting Started

3 Class-A Master is added to the
Project Explorer.
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4 In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

= EC-Engineer 1]

[£e wew petwork  gemngs e

£ Configuration Mode SR . Diagnarsis Mode

Marster

General

l Cyde Time [us) 1000 I

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

5 In the Master page, set the IP
address of the destination
Controller in IP Address, and
click the Select button to apply
the setting.

* Default IP address
“192.168.0.200" is specified in
this example.

* Do not select Slaves
connected to local system as
it is not used.

Device Editor
Master
General
Unit Kama Class-A Master
Cyche Time [us] 1000

Source MAC address

Slaves connected to local system:
Mebwack.Adaptes: O—720 TUFEE ( Intel(R) Ethernet Connection 1217.LM )

Slaves conmected bo remote system
I 1P Addness 192.168. 0 200 I

2y

: |
e °

6 Right-click on Class-A Master
in the Project Explorer, and
select Scan EtherCAT
Network from the menu.

= EC-Engineer [--]

File View MNetwork Settings Help

¢ Configuration Mode [lIS| B8 Diagnosis Mode

Project Explorer Device Editor
. Class-A Master Master |

*.. Scan EtherCAT Network

dF Append Slave General
Unit Name
% Remove Master-Unit Cycle Time
Source MAC
Slaves conn¢
& Import Slaves from ENI File N

# Change Master Unit
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7 Make sure that the slave is
displayed in the Project
Explorer.

File View MNetwork Settings

> Configuration Mode [~ Iy

~ | Class-A Master

v B Slave_ 1001 [NX-ECC203] (1001)
B 001 Module 1 (NX-5L3500)
B 00z Module 2 (NX-SIDBOD)
B 003 Module 3 (NX-50D400)
B 004 Module 4 (NX-ID3417)
| 005 Module 5 (NX-OD3256)

Help

6.5.2. Distributed Clock Setup

1 Setting Distributed Clocks (DC)
for Master

In the Project Explorer, select
Class-A Master to display the
Distributed Clocks tab page.

|| File  View Newwork  Settings  Help

< Configuration Mode [l = F23E0E: 0

B Diagnosis Mode

Project Explorer Device Editor
| ) Master| Process Data Image | Vanables | Advanced Gptions | Slave to Sia u
" ECC203] (2001)
B 001: Module 1 (NX-5L3500) k::’;“ ek
B 002: Madule 2 (NX-SID800} Stave_1001 [NX-ECC203] (1001)
B 003 Module 3 (NX-500400) Clock Adjustment

H 004 Module 4 (X-1D3417)
B 005 Madule 5 (NX-OD3256)

© Master Shift (EtherCAT Master Time controlled by Reference Clock)
Bus Shift (Reference Clock controfied by EtherCAT Master Time)
Options
] Continusus Prapagation Compencation
[ Sync Window Monitoring
Show B4Bit System Time

* |f the Distributed Clocks tab does not appear, select View
then the Expert Mode check box.

-
+ EC-Engineer [--] i
Network — Setting

File

~& Messages
Short Info

| Expert Mode

Refresh F5 ‘

2 Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).

= EC-Engineer (-]

File View Network  Settings  Help

<t Configuration Mode [l [28E08: 0

B Diagnosis Mode:

Master | Process Data Image | Variables | Advanced Options | Stave to Slave | Dstributed Clocks I

001 [NX-ECC203] (2001)
0 001: Module 1 (NX-5L3500)
B 002 Madule 2 (NX-SID300)
0 003: Module 3 iNX-S00400)
B 004 Madule £ (NX-1D3417)

B 005: Module 5 (NX-OD3256)

Reference Clock
Name Slave_1001 [NX-ECC203] (1001)

© Master Shift (EtherCAT Master Time controlled by Reference Clock)
Bus Shift (Reference Clock controfied by EtherCAT Master Time)
Options
] Continusus Prapagation Compencation
[ Sync Window Monitoring
Show B4Bit System Time
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B When using in DC mode

3 Setting Distributed Clock (DC)
for the Slave

In the Project Explorer, select
the target slave to display the
Distributed Clock tab page.

File  View Network  Settings  Help
Conig i e [N TR S Y
Device Editor
—_— = General | Modules | PDO Mapping | Variables | Advanced Options | Distributed Clack [y
- B — "
— | Distributed Clock
00%: Module 1 {NX-5L3500) T ST
ti ot
B 002 Module 2 (NX-SID800) el L
Sync Unit Cycl 1000
B 003: Module 3 (NX-500400) i M’:;{'”’ =
e |
B 004 Module 4 [NX-ID3417) e g
B 005 Module 5 (NX-DD3256) 4 Sync Units
|+ Syne Unit 0
Cyele Time
@ Syne Unit Cyele %1 1000 us
User defined 1000 |
Shift Time (us) 500

4 Select the Overwrite Mode
check box and specify Shift
Time.

File  View Network Settings  Help

-

Project Explorer

B Diagnosis Mode

= L Class-A Master General | Modules | PDO Mapping | Variables | Advanced Options | Distributed Clock |1y
- . mm
E_‘...._... pate ULt Distributed Clock
B 001: Moduh
Operstion Mode D for synchronization

B 002 Module 2 (NX-SID800)

W 002: Module 3 (NX-500400) rai ;
B 004: Module 4 (NX-ID3217) i — @
B 005: Module 5 (NX-OD3256) 4] Sync Units

] Sync Unit 0

Cycle Time
@ Sync Unit Cycle x1 1000 us

TP
I Shit Time fus) 500/ I

Correspondence between the servo frequencies of the
Controller and Shift Time values is as follows:

4 kHz : 125 us

2 kHz : 250 us

1 kHz : 500 us
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B When using in Free-Run mode
Setting Distributed Clock (DC)

I Fite  View NM su;ng. Help
for the Slave s ——
| Generai | Modules | POO Mapping | Variabies | Advarced Gptionfl Distributed Clock |
In the Project Explorer, select 8 . it Clock o
. B 002 Module 2 (NX-SIDE00) Cperation Mode FreeRun X
the target slave to display the I 0c3: vl 3 (50000 Sy Unt Crle o) o0
. X B 004 Module 4 (NX-ID3417) Overwrite Mode
Distributed Clock tab page. Ll Sync it
Sync Unit 0
e
Syne Unit Cycle 21 Dus
) User defined
Shift Time {us)

4 Select FreeRun from the drop

F=TeC Enginess [CALE BN P

down list for Operation Mode. | e oo

R Diagnosis Mode
| General | Modules | PDO Mapping | Variables | Advanced Options | Distributed Clock | [nit Co
NX-ECC203] A
B 002 Modhule 2 (NX-SID800) | Cperation Mode FreeRun v I
B 002 Module 3 (NX-5CD400) puii

B 004 Madute 4 (NX-I03417) Chnm Mol
B 005: Module 5 (NX-OD3256)

Syne Units
Sync Unit 0
Cyele Time
Syne Unit Cycle xl

) User defined

Shift Time (us)

5 In the Advanced Options tab ~ EC Engineer []
page, clear the Potential T hod ST M
Reference Clock check box.

4, Configuration Mode [l == =01

1B Diagnosis Mode

Device Editor

- | Class-A Master General | PDO Mapping | Variables | Advanced Options [Init Commands | Cot
|/ Sleve_1001 [E3NW-ECT] (2001) | Disable LAW
B 001: Module 1 (NX-5L3500)
1l 002: Module 2 (NX-SIDE00) Overwrite Watchdog
W 002 Module 3 (NX-500400) ] Set Multiglier [Reg: 0x400): i
W 004 Module 4 (NX-ID3417) [7] Set POI Watchdog (Reg. x4 10): 1000 51100000 ms)
B 005: Module 5 [NX-DD3256) [¥] Set M Watchdog [Reg: 0x420) 1000 B3 (100,000 ms)

Distributed Clocks
|| Potential Reference Clack
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6.5.3. Safety Controller Variable Settings
(1) Checking the coupler I/O allocations
Decompress the ZIP file you saved in 6.2.7 Output of Couple 1/O Allocations, open the expanded

“CouplerMemoryMap.xml” using Internet Explorer, and check the contents.

The following is an example displayed using Internet Explorer.

Name JName ———Jinde«_Jsw[ofiset Jisize [Name _————Jindex | Daiaype __Jofiser_Jie |
T e e e
SIot0(NX-ECC203)505th transmit PDO Mapping|[s<IBFE |3 |[0.00 16.00 |[SX Uit Registration Stahus 63_[7x2003.03_JARRAY [0.7] OF BYTHp.00
[NX Unit 10 Data Active Status 63][£x2005:03_J[ARRAY [0..7] OF BYTE|[8.00
SIotO(NX-ECC203)512th transmit PDO Mapping|[<IBFF |3 [1600  |1.00 |Sycoac Frror Statws _ |[Fx2001:01 JUSINT 16.00 -
SlotO(NX-ECC203)Padding TxPdo axIBF4 3 1700 [L00 | . . -
Slot4(NX-ID341 7)lnput Data Set | EXIAOC |3 1800 (004 |foospion 05001 |BOOL 1500
Input Bit 01 Ex6060-02_|[BOOL 18.01
[nput Bit 02 Ex6060:03_|BOOL 18.02
[nput Bit 03 [Fx6060:04_|[BOOL 18.03
SIotO(NX-ECC203)Padding TxPdo sxIBF6 3 [18.04 104 | — . - ]
SlotI(NX-SL3500)Input Data Set 1 Fx1A0 13 [120.00 {1400 |Nodel Unit2 £x6000:01 |[ARRAY [0..6] OF BYTE|20.00 |
Node1 Unit3 [£x6000:02_|[ARRAY [0.5] OF BYTE|27.00
Padd: £x6000:03_|[ARRAY [0..0] OF BYTE|}3.00
Slot] (NX-SL3500)Input Data Set 2 x1A0l 33400 (200 [Safcry €PU Stas 600401 JUINT 33.00
Slot2(NX-SIDS00)Input Data Set 1 x1atd 3 (3600 [7.00 [FSoE slave oMD #x6020.01 J[USINT Bsoo oo
Safety Input 1st Word Ex6021:01
FSoE Slave CRC_D [£x6020:03
FSoE Slave Conn_ID F26020:02
Slot2(NX-SID800) Input Data Set 2 “x1A05 3 [43.00 (300 |/Singrd nput 1st Word Ex6022.01
Standard Input 2nd Byte [Ex6022:02 ]
Slot3 (NX-50D400)Input Data Set | EXIAOS |3 [46.00  [6.00 |FsoE Slave CVD lixc030:01 |
Safety Input 15t Byte #x6041:01
|FSoE Slave CRC 0 £x6040:03
[FSoE Slave Conn_ID Ex6040:02
|FIot (N X-50D400 ) lmput Data 5et 2 EXIAD |3 5200|200 |Suundard tnpur 1st Byte corz.01 [UsneT 5200|100
Standard Input 2nd Byt #x6042:02_|[USINT 5300 JLoo
[RxPDO
SlotS(NX-0D3256)Output Data Set 1 Exl610 |2 Jo.00 0.04 [Gutpt Bit 00 x7080:01 |[BOOL .00 M
Cutput Bit 01 “x7080:02_|[BOCL .01 .01
Output Bit 02 £x7080:03_|[BOOL .02 0.01
[Output Bit 03 x7080:04_|[BOOL 0.03 .01
SIot0(NX-ECC203)PaddingRxPdo ex17F6 |2 004 104 — — — 103
Slot] (NX-SL3500)Output Data Set 1 sx1600 (2 J2.00 14.00 [Nodel Unit2 [£x7000:01 |[ARRAY [0..6] OF BYTE|[2.00 7.00
[Nodel Unit3 £x7000:02_|[ARRAY [0..5] OF BYTE|[9.00 [5.00
Padding £x7000:03 |[ARRAY [0.0] OF BYTH[15.00  |[1.00
Slot] (NX-SL3500)Output Data Set 2 exiso1 |2 Jisoo  Jo.oo
SIot2(X-SID800)Output Data Set | Fx1604 |2 1600|700 |rso naver VD 702001
Safiety Output Lst Word £7021:01
[FSoE Master CRC_0 Ex7020:03
|FSoE Master Conn ID 4x7020:02 K
Slot2(NX-SIDB00)Output Data Set 2 x160s  [2 2300 [5.00 |[Sndard Output 15t Word Gooazol JUNT |00 |00 |
Standard Output 2nd Byte Ex7022:02
SIot3(NX-S0D400)Dutput Data Set | xI608 |2 2600 [600 [roor e oD [Ecodoor
Safcty Output 1st Bytc Ex7041:01
SoE Master CRC 0 Ex7040:03
SoE Master Conn_ID Ex7040:02
SIot3(NX-S0D400)Output Data Set 2 ExI600 |2 [P200 200 |momi—s o xToiz01 [JSINT
Standard Output 2nd Byte Ex7042:00_|[USINT
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(2) Setting Input Data

Register the following input data.

- Slot1(NX-SL3500)Input Data Setl
- Slot1(NX-SL3500)Input Data Set2

Slot1(NX-SL3500) nput Data Set 1 [Node1/Unit2 [x6000:01 |[ARRAY [0.6] OF BYTE|2000 7.0
[Nodel/ Unit3 [Fx6000:02 |IARRAY [0..5] OF BYTE|27.00 3
Pzd.ding [Fx6000:03 ||ARRAY [0..0] OF BYTE33.00 .
Slot] (NX-SL3500) nput Data Sct 2 Fafety CPU Sarus w6001 JUINT B
S o > T oe0 700 FSeE Siave VD FRo2001 JUSINT 600100
[Safety Input 1st Word [Fx6021:01 |UINT 37.00 2.00
[FSoE Slave CRC_0 [Fx6020:03 JUINT 39.00 2.00
[FSeE Slave Conn_ID [Fx6020:02 |[UINT 141.00 2.00
Slor2(NX-SIDE00) lnput Data Sct 2 EIAGS 3 [#3.00 500 [Siandard taput 1ot Word x602201 |UINT 300|200
[Standard Tnput 20d Byte [Fr6022:02_|[USINT 500 Jroo
S0 (NX-50D400) Input Data Set 1 FX1A0S |5 [46.00 [6.00 |Fsorsmecnd  [eeowor st w600 oo
Safety Input 1st Byte #x6041:01 |[USINT 47.00 1.00
FSE Slave CRC_0 Ex6040:03_||[UINT 500|200
FSoE Slave Conn_ID #x6040:02 [[UINT 50.00 00
Slot3(NX-SOD400) nput Data Set 2 109 3 15200 200 Standard Input st Byte £x6042:01_J[USINT 5200 J[Loo
Standard Input 2nd Byte #x6042:02 |[USINT 53.00 1.00

File  View Network Seftings  Help

1 Select a safety controller in the
Project Explorer pane of e —
EC-Engineer. o

B Ciagnosis Mode

£ Class-A Master
Variables
o Name Datatype ' Groupinfo Offset - | Sze
Display the Variables tab page. I 003 Module 30945000
B 004 Module 4 (NX-1D3417)
[l 005: Module 5 (NX-0D3256)
Edit Variable
New
Classic View | Flat View | Topology View

2 [Slot1(NX-SL3500)Input Data » Add Variable = | B [t
Setl]
_ _ _ Group |Module 1 (NX-5L3500).Input Data Set 1 |
Registering Nodel1/Unit2
Datatype |usmnT |
(NX-SID800) Count | 18
Combine O
Click New in the Variables tab ok Cancel
page, and register two variables
shown on the right.
[FSoE Slave CMD [ax6020:01 [JUSINT |

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: USINT
Count: 1

[Safety Input 15t Word

[Exs0z101 JfuINT |

FSoE Slave CRC_0 |[Ex6020:03  JUINT
FSoE Slave Conn_ID |2x6020:02 |UINT

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: UINT
Count: 3
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3 [Slot1(NX-SL3500)Input Data
Setl]
Registering Node1/Unit3
(NX-SOID400)

Click New in the Variables tab
page, and register two variables
shown on the right.

[FSoE Slave CMD [#x6040:01 |[USINT
|Safety Input 1st Byte |#x6041:01 |[USINT

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: USINT

Count: 2
|FSoE Slave CRC 0 |4x6040:03 |[UINT
[FSoE Slave Conn ID l#x6040:02 |[UINT

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: UINT
Count: 2

4 [Slot1(NX-SL3500)Input Data
Setl]

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: USINT

Registering Padding Count: 1
Click New in the Variables tab
page, and register the variable
shown on the right.
5 [Slot1(NX-SL3500)Input Data [Safety CPU Status |[Ex6004:01 |[UINT [F400 Jzoo |

Set?]
Registering Safety CPU Status

Click New in the Variables tab
page, and register the variable
shown on the right.

Group: Module 1(NX-SL3500).Input Data Set 2
Datatype: UINT
Count: 1

6 Checking Input Data

Make sure that the settings
(Input) in the Variables tab page
are correct.

Device Editor

[ MDP Siot properties | Variables ‘

Variables
bl i
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Input Data Set 1.Variable 0 USINT  [Default] N 180 10
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Input Data Set 1.Variable 1 UINT [Default] IN: 19.0 20
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).Input Data Set 1.Variable 2 UINT [Default] IN: 210 2.0
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Input Data Set 1.Variable 3 UINT [Default] IN: 230 20
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).Input Data Set 1.Variable 4 USINT  [Default] N: 250 1.0
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).Input Data Set 1.Variable 5 USINT [Default] IN: 260 1.0
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Input Data Set 1.Variable & UINT [Default] IN: 270 20
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Input Data Set 1.Variable 7 UINT [Default] IN: 290 2.0
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).Input Data Set 1.Variable 8 USINT [Default] IN: 310 1.0
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Input Data Set 2.Variable 0 UINT [Default] IN: 32.0 20

34



(3) Setting Output Data

Register the following output data.

- Slot1(NX-SL3500)Output Data Setl
- Slot1(NX-SL3500)Output Data Set2

Slot] (NX-5L3500)0utput Dara Ser 1 ex1500 T o o0 Nodel Unit2 c7000:01 |JARRAY [0.6) OF BYTE |[2.00 700
[Nodel Unit3 =x7000:02  JIARRAY [0..5) OF BYTE |[9.00 5,00
Padding Fx7000:03 JIARRAY [0.0) OF BYTE |[15.00 1.00

Slat] (NX.SL3 300 t Diaga Set 2 #1601 2 |l16 00 000

Sler2(NX-SIDEC0 Output Data Set | Felo0d 2 |60 700 FSoE Master CMD #x7020:01 JUSINT 1600 100
Safery Qutput 15t Word 02101 JUINT 1700 200
FSDE Master CRC_0 FRT020:03  |UINT 19.00 200
[FSDE Master Conn_ID Ex 702002 |UINT 21.00 2 00

Slot2(NX-SIDEGICutput Data Set 2 wx1605 |2 5500 599 [Siandard Output 1st Werd | X
[Standasd Output 20d Byte [[rroz2:02 JUsINT [200  Jroo

Slot3(NX-50D400)Ourpur Data Set | <1608 [0 2600 [[600 [k Mawes CVD raT0001 JosneT AT ]
|[Safery Qutpur 1st Bye =% 7041:01JUSINT 2700 100
[FSoE Master CRC_0 = 7040:03|UINT 2500|200
[ﬁuﬁ Master Conn_[D i 7040:02  |[UTNT 30,00 2 00

Slot3(NX-S0D400)Outpus Data Set 2 =x1609 |2 [200 [[200 'rs‘mdudww TH B [F=rorzo1 JusiT Fz i
[Standasd Output Jud Byte [lx7042:02 JUSINT F3.o0 JLoo

= EC-Engineer [--]

7 Select a safety controller in the

File  View Network Seftings  Help

Project Explorer pane of R oo e
EC-Engineer. =B e

- Variables

. A l e s : roup info  Offyet ~ | Size

Display the Variables tab page. N O

W 005 Module 5 (NX-0D3256)

Edit Variable
Classic View |Fiat View | Topology View e
8 [Slot1(NX-SL3500)Output Data _
[[FSoE Master CMD [¢x7020:01 |[USINT |

Setl] .

Registering Nodel1/Unit2

(NX-SID800) Group: Module 1(NX-SL3500).Output Data Set 1
Datatype: USINT

Click New in the Variables tab Count: 1

page, and register two variables

shown on the right. |[Safety Output 1st Word #%7021:01 |[UINT
{[FSoE Master CRC_0 #7020:03 |[UINT
|[FSoE Master Conn_ID |l#x7020:02 [lUINT

Group: Module 1(NX-SL3500).Output Data Set 1
Datatype: UINT
Count: 3
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9

[Slot1(NX-SL3500)Output Data
Setl]

Registering Node1/Unit3
(NX-SOID400)

Click New in the Variables tab
page, and register two variables
shown on the right.

[F$oE Master CMD [ExT040:01 JJUSINT

[Safety Output 15t Byte [ExT041:01 [USINT

Group: Module 1(NX-SL3500).Output Data Set 1
Datatype: USINT
Count: 2

FSoE Master CRC_0 |[e7040:03 |[UINT

FSoE Master Conn ID | #xT040:02 |'L'ETQT

Group: Module 1(NX-SL3500).Output Data Set 1
Datatype: UINT
Count: 2

10

[Slot1(NX-SL3500)Output Data
Setl]
Registering Padding

Click New in the Variables tab
page, and register the variable
shown on the right.

Group: Module 1(NX-SL3500).Output Data Set 1
Datatype: USINT
Count: 1

11

[Slot1(NX-SL3500)Output Data
Set2]

* Qutput Data Set2 is not used
and does not need to be set.

12

Checking Output Data

Make sure that the settings
(Output) in the Variables tab
page are correct.

Device Editor

| MDP Slot Properties | Variables |

Variables

G T T —
Slave_1001 [NX-ECC203].Medule 1 (NX-5L3500).0utput Data Set 1 Variable 0 USINT  [Default]  OUT:
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Output Data Set 1 Variable 1 UINT [Defaul]  OUT:
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).0utput Data Set 1.Variable 2 UINT [Default]  OUT:
Slave_1001 [NX-ECC203].Medule 1 (NX-5L3500).0utput Data Set 1.Variable 3 UINT [Default] ouT :
Slave_1001 [NX-ECC203].Medule 1 (NX-5L3500).0utput Data Set 1.Variable 4 USINT [Default] ouT :
Slave_1001 [NX-ECC203].Module 1 (NX-SL3500).Output Data Set 1 Variable 5 USINT  [Default]  OUT:
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).0utput Data Set 1.Variable & UINT [Default]  OUT:
Slave_1001 [NX-ECC203].Module 1 (NX-5L3500).Output Data Set 1 Variable 7 UINT [Default]  OUT:
Slave_1001 [NX-ECC203].Medule 1 (NX-5L3500).0utput Data Set 1.Variable 8 USINT [Default] ouT :

00 1.0
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6.5.4. PDO Map Settings

1 In the Project Explorer, select
the target slave to display the
PDO Mapping tab page.

=TeC Eromest €1

File  View

Progect Explorer

Metwork  Settings  Help

B Ciagnosis Mode

General | Modules | PDO Mapping |Varisbles | Advanced Options

Inpuis

'] wzmhgm;.gogm; w [ 505tn transmit FDO Mapping aabey |
I 003: Module 3 (NX-50D400) Narme Incex Bit Length
B 008 Modul 4 (NX-ID2417) NOX Uinit Registrati| 0300303 7]
Bl 005: Madule 5 (NX-0D3256) NOC Uit U0 Data | 03300603 o b
w [ 51zih transmit FDO Mapging O18FF
Name Index Bit Length
Sysmac Error Stat, | (a2002:01
w [ 5015 transmit FOO Magping ul8Re
Mame Index Bit Length
-
v Moduie £ (NX-D341Tdnput Data Set L GlA0C
2 Setting PDO mapping (Inputs) Inputs
¥ 505th transmit PDO Mapping OxiBFE
Confirm the check boxes in the Name Index Bit Length
|nputs fleld MX Unit Registratic | Ox3003:03 &4
MNX Unit I/O Data # | Ox3006:03 54 5
A4 512th transmit PDO Mappin 1BFF
* |f you do not want to use data e
. . Mame Index Bit Length | 4
in the Inputs field, clear the
| d | d h k Sysmac Error Statu | Ox2002:01 8
current ISplayed checC ,
y p y -, 501st transmit PO Mapping Ix1BF4
boxes' Marne Index Bit Length
--- 8
v [V Module 4 (N¥-ID3417)Input Data Set 1 OxlADC
3 Setting PDO mapping (Outputs) outputs
w [J] Module 5 {NX-OD3256).Output Data Set1  Ox1610

Confirm the check boxes in the
Outputs field.

* |f you do not want to use data
in the Outputs field, clear the
currently displayed check
boxes.

Mame Index
Output Bit 00 Ox7080:01
Cutput Bit 01 0x7080:02
Output Bit 02 0x7080:03
Output Bit 03 Ox7080:04

[V] ModuleAlignPDO

Name Index

Module 1 {NX-SL3500,.0utput Data Set 1

Mame Index

El

Bit Length

1

1

1

1

x17F6

Bit Length

12

Ox1600

Bit Length
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6.5.5. Coupler I/O and Variable Allocations
(1) Checking the coupler I/O allocations
Decompress the ZIP file you saved in 6.2.7 Output of Couple 1/0 Allocations, open the expanded

“CouplerCopylInfo.xml” using Internet Explorer, and check the contents.

The following is an example displayed using Internet Explorer.

Original device name||Original slave model ||Original SM||Original bit offset Destination device name|| Destination slave model ||Destination SM || Destination bit offset  ||Bit size
E001 INX-ECC203 3 160 E001 INX-ECC203 2 128 56
E001 INX-ECC203 3 216 E001 INX-ECC203 2 208 48
E001 INX-ECC203 3 288 E001 INX-ECC203 2 16 56
E001 INX-ECC203 3 368 E001 INX-ECC203 2 72 48

(2) Setting Input Data

Associate the following items:

- Module 1 (NX-SL3500).Input Data Set 1, and Module 2 (NX-SID800).Output Data Set 1
- Module 1 (NX-SL3500).Input Data Set 1, and Module 3 (NX-SOD400).Output Data Set 1

Copy bit size (56 bits) from the source bit offset (160 bits) to the destination bit offset (128 bits).

[WM%WWWM

E001 INX-ECC203 3 160 E001 INX-ECC203 2 128 56
E001 INX-ECC203 3 216 E001 INX-ECC203 2 208 48
E001 INX-ECC203 3 288 E001 INX-ECC203 2 16 56
E001 INX-ECC203 3 368 E001 INX-ECC203 2 72 48

1 Select Class-A Master in the
Project Explorer page of
EC-Engineer.

Display the Slave to Slave tab
page.
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2 Associate the variables of

Master | Process Data Image | Variables | Advanced Options| Slave to Siave | Distibuted Clacks | Muitple Tasks

Inputs Module 1 e o s -

(NX-S L3500) ' I n p ut Data' Set 1 i :: :A q::oscLls:oDﬁwt Dota Set 1 [112 Bits. ; ‘ Mody 00).Output Ciata Set 1 [112 Bit i

-SL3500).0

t Cota Set 2 [0 Bas]

with Outputs Module 2 Mocd 2 (104:510800) Outs Dat Sa 1 [56 s B
(NX-SID800).0Output Data Set e
1.
Associate the following items:
Select an (NX-SL3500).Input Inputs Outputs
Data Set 1 item, then select Variable 0 FSoE Master CMD
the corresponding Variable 1 Safety Output 1st Word
(NX-SID800).Output Data Set Variable 2 FSOE Master CRC_0
1 item and click >>. Variable 3 FSoE Master Conn_ID
3 Associate the variables of
Inputs Module 1 S shes i
(NX-SL3500).Input Data Set 1 : AL | e e
with Outputs Module 3 ME;J:?{MTD:M“ &
(NX-SOD400).Output Data st
et 1 .
Associate the following items:
Select an (NX-SL3500).Input Inputs Outputs
Data Set 1 item, then select Variable 4 FSoE Master CMD
the corresponding Variable 5 Safety Output 1st Word
(NX-SOD400).0Output Data Variable 6 FSoE Master CRC_0
Set 1 item and click >>. Variable 7 FSoE Master Conn_ID

* Variable 8 does not need to be allocated.
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(3) Setting Output Data

Associate the following items:

- Module 2 (NX-SID800).Input Data Set 1, and Module 1 (NX-SL3500).Output Data Set 1
- Module 3 (NX-SOD800).Input Data Set 1, and Module 1 (NX-SL3500).Output Data Set 1

4 Associate the variables of Inputs  E———————
Module 2 (NX-SID800).Input i
Data Set 1 with Outputs Module i~
1 (NX-SL3500).0Output Data

Set 1.

Select an (NX-SID800).Input Associate the following items:

Data Set 1 item, then select the Inputs Outputs
corresponding FSoE Master CMD Variable 0
(NX-SL3500).0Output Data Set Safety Output 1st Word Variable 1
1 item and click >>. FSoE Master CRC_0 Variable 2
FSoE Master Conn_ID Variable 3

Master | Process Data Image | Variabies | Advanced Options | Sive to Slave | Distributed Clocks | Multiple Tasks

Module 3 (NX-SOD800).Input T -
Data Set 1 with Outputs Module ;

1 (NX-SL3500).0utput Data e
Set 1. ’

5 Associate the variables of Inputs I ——

Select an (NX-SOD800).Input Associate the following items:

Data Set 1 item, then select the Inputs Outputs
corresponding FSoE Master CMD Variable 4
(NX-SL3500).0utput Data Set Safety Output 1st Word Variable 5
1 item and click >>. FSOE Master CRC_0 Variable 6
FSoE Master Conn_ID Variable 7

* Variable 8 does not need to be allocated.

40



6.5.6. Creation of an EtherCAT Network Configuration File

Click Export ENI on the upper
1
part of the EC-Engineer page.

= EC-Engineer [--]

File View Network Settings Help

£ Configuration Mode | = Export ENI I B8 Diagnosis Mode

2 Enter a file name, and then click
Save to create an EtherCAT
network configuration file.

= Export EtherCAT-Network-Information (ENI) File

@@v . » Computer » Local Disk (C:) » tmp - || Search tmp e
Organize « Mew folder d= - @
=
ﬂ Local Disk (C) Mame Date modified Type
J DeltaTau
| inetpub Mo items match your search.
J Intel

J OE-Downloade

J Perflegs
/ Program Files

)
4
)
)
. Omron
)
)
0 Program Files {
)

— Sl T (i D

1
I File name: I -
Shve as type: IEthelCAT-Ne‘(wolk-infulma’(ion (ENI) Files (*.xml) v]

‘# Hide Folders Save Cancel
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I 6.6. Controller Settings

6.6.1. EtherCAT Network Configuration Settings

1 From the Tools menu of Power
PMAC IDE, select System Setup
to display System Setup.

PowerPMAC System Setup ; Onlne{192.168.0,200:554]

File Datahase

A Powwns PMAC {19 1680 780

G EthercAT

EtherCAT Master type: ACONTIS

Browse to eni file

EtherCAT License Status: EtherCAT 1D Devices Liconss Only

Browse

Duwnicad ENI e ‘

2 Click Browse, and load the
EtherCAT network configuration
file created in 6.5.6 Creation of an
EtherCAT Network Configuration
File.

PowerPMAC System Setup ; Onlne{192.168.0,200:554]

File Datahase

= EtherCAT~

EtherCAT Master type: ACONTIS

Browse to eni file

EtherCAT License Status: EtherCAT 1D Devices Liconss Only

Dnnwricad N e

Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

—
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices Licanse Only
EtherCAT Master ype: ACONTIS

Browse to eni file

B{m

6.6.2. EtherCAT Communications Check

Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H]

ECAT[0].Enable=1

2 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to 1.

* The OP mode is entered and
EtherCAT communications are
established.

Watch: Online[192.168.0.200:55H] ~ 1 X
Send| 20 C d R
end oo ond omman esponse
_ PN P S 17140
ECATI[0].Enable 1
ECATIO].Error 50
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3 After making sure that correct
communications are available, run
the ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

Watch: Online[192.168.0.200:55H] > 1 X
Send n Command Responsze
Demand
Sys.ServoCount 18213817
ECATI[0].Enable 1
ECAT[0].Error 50
==
Terminal: Online[192.168.0.200:55H] ~ 0 X

terminal
mmunicatio
owerP

ECAT[0].Enable=0

4 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to O.

Watch: Online[192.168.0.200:55H]
Send B Command Rezponse
Demand
Sys SanaConnt 15525814
ECAT[0].Enable 0
ECAT[O].Error 50
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6.6.3. EtherCAT Variables Settings

1 In the System Setup page,

right-click on
Master[0].Deactivated to
display the pop-up menu, and
select Export EtherCAT
Variables.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File Database

5 PowerPMAG {192.168.0.201

rt EtherCAT Variables

EterCAT.

TITET G CICETTS e TS LtI]ErCAT |0 Device

EtherCAT Master type: ACONTIS

Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

-
- Save As

@'O”-" <« My Documents » o s 5 2 B
= - ———

Organize v New folder
W Favorites = Name

I Desktop e

& Downloads Clanguage

%] Recent Places Configuration

Documentation

= Libraries L ! Log
) Documents | PMAC Script Language
& Music
&) Pictures
BB videos

% Computer P
& Local Disk (C)

Date modified Type Size
7/8/20168:42 PM  File folder
7/8/20168:42 M File folder
7/8/20168:42PM  File folder
7/8/20168:42 PM  File folder
7/8/20168:42PM  File folder
7/8/20168:42 PM  File folder

File name:  ECAT_Variables|

Save astype: | ppmac header files (*.pmh)

5

= Hide Folders

Save Cancel

The created EtherCAT variable
definition file is added to under
Global Includes of PMAC
Script Language in Solution
Explorer.

Position: Online[19... ~ & X || Velocity: Online[192.... v & X | | Following Error: Onll

- ecat varizbles)h ecat_variablespmh

~ 1 x| Selution Explorer - Solution".. ~ & X

nu |

[ Solution 'PowerPmac?' (L project)
- ] PowerPmac2(192.168.0.200:x¢
£3 C Language

[ Configuration

[ Decumentation

g Log

b BB

#define Slave_0_3220_1_OutputBit00
#define Slave 0_3220_2 CutputBit0l
#define Slave 0_3220_3_OutpurBit02
#define Slave_0_3220_4_OutputBit03
#define Slave 0_3220_5_CutputBic04
#define Slave_0_3220_6_OutputBit05
#define Slave 0_3220_7_CutputBit0s

ECAT[0] .IO[O] .Data
ECAT[0].IO[1].Data
ECAT[0] .IO[2].Data
ECAT[0] .IO[3].Data
ECAT[0] .IO[4] .Data
ECAT[0] .IO[5].Data
ECAT[0] .IO[6] .Data «

- (&7 PMAC Script Language
£+ [ Global Includes

[Eil =cat varisbles.pmh)

[ Kinematic Routines
3 Libraries

3 Motion Programs
3 PLC Programs

|

——— v
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6.6.4. Writing the User Program

Create programs to be used to check operations.

A specific language is used for the operation check programs. Refer to Power PMAC User’s

Manual and Power PMAC Software Reference Manual for details.

1 In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs —plcl.plc.

F 0 Terminal
Exaio - Lkt

PR_tushinm_tacetpl
N pp_dsablens
| pp_inc_disable
5] pp_inc_startuptst
e tavecly
miyecatcip” ccatactivatelucly | XI510080 | 20151028 pmb s x & pestartup.bie
) Documentation
Loy
L PMAC Sonpt Lenguage
= Global Inchades
2151028 pmk
el defintinni

J Kinematic Routines
o Ld Lebewnes
W 23 Mtion Programs

Propertier - 3

" ||| ecatsrthatelloly Fie Properties
x5

x

In the programming area of the
plcl.plc tab page, write a
program as show on the right.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable = 1;

This sample program blinks the P1000=Sys.Time+1;

NX-OD3256 output indicator
every second.

* In this example, PDO
mapping is assumed to be the
default setting. If you want to
change PDO mapping, rewrite

while(P1000>Sys.Time){};
Slave_0_ 7080 2 OutputBit0l1 = 1;

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

Slave_0_7080_2_OutputBit01 = 0;

close

the “Slave_0....” description.
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3 Setting the start of the user

program ndow  Help
thug - Ay CPU - | [ 1800 - | P = | Terminal
o Onl a I Sohston Brpledrer - Sohtion™_ « 3 X
In the Solution Explorer pane,
open Project name —

Configuration —

o Inckade
20150028k
PP progh
i Lsbwmries
¥ 3 Resitame Eoutices

2 Configueation

prodisable.txt | myecatcfg | etatactvated.cly | 200500080 W

pp—dlsabletXt L o [f¥ill all che motors (This cpriorl Scithciwel.cy

& [ Documentation

Jl Leg

pp disable twt File Propeties
sl

4 In the programming area of the
pp_disable.txt tab page, add enable plc 1;
the program shown on the right
to the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

6.6.5. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.
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1 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

- Power PMAC Suite (Administrator)

File Edit View Project Build Debug Tools DeltaTau V

G- - O el i | % B3 @9 -0 S [

hoar | EEE|E 2O 103 & B
@ Terminal 4 Position [Z] Watch |8 Status @ Jog Ribbon | < ¢
Watch: Online(192.168.0.200:55H] ~ 1 x
Send g;mand Command Response
1 | |ECATIOlEnable 0

#1- Make sure that ECAT[0].Enable=0

Terminal Online[192.168.0.200:55H]

2 Downloading a project

Right-click the project name in
the Solution Explorer pane on
the upper right of the IDE
screen, and select Build and
Download All Programs to run
the build and download.

Solution Explorer - Powe... » 0 ¥

=

(oA Solution 'PowerPmac_ECC201+S
=*m | PowerPmac_ECC201+5afe
= [ C Language i | Build
+ [ Background H Clean
+- [3 CPLCs
w1 (3 Include Debug
i [ Libraries Build and Download All Programs
i #- [ Realtime RdY Download All Programs
+- [ Configuration
) Map PMAC Variables
+- [ Documentation
#- £ Log Add Macro Project
#- £ PMAC Script Lan % | cut
* | Remove
Unload Project
1 LilJ i | Properties
Properties >~ I'X ] r

3 Make sure that there are no
errors in the Output tab page.

* |If the transfer fails, check
details of the error in the Output
tab page.

If the error is a program error,
you must review the program.

If the error is related to
EtherCAT settings, return to
System Setup and check
whether there are any incorrect
settings.
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4 The program starts running
when it has been downloaded Terminal: Online[192.168.0.200:55H]
successfully.

EtherCAT communications are
in the OP state. Make sure that

|er|ab|e plc1

the NX-OD3256 output indicator
blinks.

* If the indicator does not blink,
check that the ECAT[0].Enable
value is 1 in the Terminal or
Watch pane.

If the value is 0, run the following
command from the Terminal
pane.

enable plc 1

5 After you have confirmed an Terminal: Online[192.168.0.200:55H]
appropriate operation, save the |EEitaEg
project to the Controller.

ave
Run the save command from the 'S—I
Terminal pane.

* The transferred project is not
yet saved to the Controller at
this stage.

If you turn OFF the power to the
Controller, the transferred
project will be discarded.
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7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File i. B pp_projh
----- 1 Libraries
[+~ [ Realtime Routines
Create a Configuration File to (SREI] Configuratien
----- | 7| ecatag Add »
save parameters you have || | ..
M == | Properties
hanged in System Setup tothe || = L pp_as =
Cc - g ystem oetup tothe | | =| pp_dis Upload Config Files
project. ; ppIne Download Config Files
----- Generate Configuration File
Right-click Configuration in the - [ Docamentation
Solution Explorer pane, and e PR e

select Generate Configuration
File.

A Configuration File is added to
Configuration.

2 Right-click on the Configuration

. Configuration

m

e and from the ment1 <elect - [ rininal 11415 cfol
File, and from the menu, select (A ST
. I [ 3 | Open
Check To Download Config File .. 7 Open With..
to include it in files to be - ; [ | View Code
downloaded. . = Exclude From Project
""" 5 >( Delete
..... :, Rename

Check To Download Config File

Prope
.| iz | Properties
Lalgtelly
3 Saving a Project 4 Power PMAC Suite
Edit View
. MNew
In the File menu, run Save All to open
save the project on the computer. Add

1 | Close Solution
Upload Project

|l | Save uPowerF

Save uPowerF

i@ Save Al
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal pane, type the
$$$*** command to reset the
Controller settings to factory
default.

Terminal: Online[192.168.0.200:55H]

CoCres

3 In the File menu, Click Open —

< Power PMAC Suite (Administrator)

Projectlsolution tO |0ad the Edit View Tools DeltaTau Window Help
iect that d New IRk ‘Del:L.g -|,a|~-, CPU - %
projec at you saved. » |z Project/Solution... Ctrl+Shift+0 _
& | File... Ctrl+0 a X || velocity:
Response =
T o e
ems As
Ctrl+Shift+5

|:| +P

Recent Files 4

Recent Projects »

Exit

4 From the TOOIS menu Of Power PowerPMAC System Setup : Ondne{ 192.168.0,200:55M] 1 (2]
File Database
PMAC IDE, select System Setup  E e —
to display System Setup. ) T
EtherCAT Master ype: ACONTIS
Browse to eni fils Browse Duwnicad ENI e
5 Click Browse, and load the ENI e
EtherCAT.

file that you created in 6.5.6
Creation of an EtherCAT Network
Configuration File.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

| Download ENI file |

6 Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

o
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

B{m
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7 Right-click Configuration in the S —

Solution Explorer pane, and S
) ) = £ Include -
select Download Config Files to - [] 20160204.h
download the file to the Controller. - LI pp_projh
- [ Libraries

+- 1 Realtime Routines
== Configuration

- || ecatactiva add R
- | myecat.cf] -
pn_custon ‘= | Properties
__| pp_custon Upload Config Files
- = pp_di Downlead Config Files
=l pp_disablg load Config Fil
’ ﬁ pp_inc_dis Generate Configuration File
- |2 pp_inc_std.
- || pp_sawve.cfg

J

- 2] pp_startup.txt .

8 Right-click the project name in the |Selution Explorer - Powe...~ 1 X

Solution Explorer pane, and =
. [ Solution 'PowerPmac_ECC201+8
select Build and Download All 28w ] PowerPmac_ECC201+safe
Programs to run the build and I+ (5 Clanguage | & | Build
cl
download. =
Debug 3

Build and Downlead All Pregrams

When the download process is - [ Realtime Rod

+ 3 Configuration
complete, make sure that there - £a Documentation

are no errors in the Output tab o [ Log od Macro Frojet
+-- [ PMAC Script Lan % | cut

Download All Programs

Map PMAL Variables

age.
pag # | Remove
Unlead Project
a LLI] i | Properties
Properties ~ I'X ] r
O Stopping a program Terminal: Online[192.168.0.200:55H] ~ 1 X
If a program is running, execute |
the following command from the
i “disable ple 1
Terminal pane to stop the
program.
disable plc 1 Terminal: Online[192.168.0.200:55H] S

ECAT[0].Enable=0

||ECAT[D].EnabIe=D
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10 Saving the downloaded settings

and programs

After the download process is
complete and you make sure that
there are no errors in the Output
tab page, run the save command
from the Terminal pane.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

|SE'U'E

11

Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$$

Terminal: Online[192.168.0.200:55H]

||555
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8. Appendix Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.5 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJ[O].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.5.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status

You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode

of Acontis EC-Engineer.

B System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power

File  Database

549 PowerPMAC (192.168.0.200)
¢ s Hardware Diagnosis

4 Motors

YY) ctcr{0] Activated

—
EtherCAT.

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

C\U=sers\OMRON_IPC_1\Desktopleni.xm!

[Browse| [ Download ENIfile
STave status
ECAT[®].5laveCount=2 Mo Status Emor  Description
ECAT[@].TxTime=3
ECAT[®].RxTime=1 0 o] Mo Slave_1001 [GX0D1611]
BERE L= D e 1 oP No | Slave_1002 [GX-MD3218]

B Diagnosis Mode of Acontis EC-Engineer

You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.

i B EC-Engineer [__]- _\E@lﬂﬂ

|| File

View

Network

Settings
#. Configuration Mode |

Project Explorer

- @ Class-A Master <connacted>

Help

| & Slave 1001 [GX-OD1611] (1001) |

[ Diagnosis Mode

Device Editor
General |'\-"ar|'ables || ESC Register ” EEPROM || Extended Diagnosis " DC Diagnosis ” CoE Q[4][]

State Machine

@ Slave 1002 [GX-MD3218] (1002}

Current State |0p
Requested State |0p
Init
Change State Pre-Op Safe-Op
Error State
Current No error
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

-

= Network Mismatch Analyzer

m@ﬂ

List of slaves

Name Configured Slave
Slave_002 [R3& | R88D-KNO1L-ECT [2]

Slave_003 [R8S | RESD-KND1L-ECT [3]

0x00020001 0

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Revision Alias | Network Slave

0x00020001 | O

Revision Alias

REBD-KNO1L-ECT [2] | 0x00020001 | 1

Close

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status: Online[192.168.0.

Motor Status ] Coordinate Status

Global Status

Description

BufSizeErr
ConfigloadErr
Default
FileConfigErr
FlashSizeErr

Status

AbortAll False

False
False
False
False
False

MACRO 5tatus ] ECAT Status ]

Description
HWCha-ngeErr
MoClocks
ProjectLoadErr
PwrOnFault
WD TFault

Status
| i:alse
False
False
False
MNoFault
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Bl Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Coordinate Status] Global Statusl MACRO Status l ECAT Status ]
Motor 0 = ® Motor not activated

| Description Status Description Status
_ False IZtFauIt. i:alse
AmpFault False InPos False
AmpWarn False LimitStop False
AuxFault False MinusLimit False
BIDir Plus PhaseFound False
BlockRequest False PlusLimit False
ClosedLoop False SoftLimit False
Csolve False SoftLimitDir Plus
DacLimit False SoftMinusLimit False
DesVelZero False SoftPlusLimit False
Encloss False SpindleMotor False
FeFatal False TraceCount 0

| FeWarn False TriggerMove False

| GantryHomed False TriggerMotFound False
HomeComplete False TriggerSpeedsel MaxSpeed
HomelnProgress False

B Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Status: Onling[192.

SSH]

Motor Statu CDDn:ImateStatu] Global Status] MACRO Status l ECAT Status ]
Coordinate System 0 =
Description Status Description Status it
|AddedDwelbis IS LinToPviBuf False
AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookfheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LockAheadReCalc False
BufferWarn 0 LockAheadStop False
CC3Active False LockAheadWrap False =
CCAddedArc False MinusLimnit False i
CCMode Off MovelMode LineCircle
CCMoveType Dwell PlusLimit False
|| CCOffReq False Proghctive False
| ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegMove Off
Encloss False SegMovelccel False
EndDelayActive False SegMoveDecel False B
ErrorStatus MoError SegStopReq False
FeedHeld Off SharpCornerstop False
FeFatal False SoftMinusLimit False
u‘-’am False SoftPlusLimit False
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9. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATI[i].Enable

ECATI[i].LPIO[K]

ECATIi].Slave[j]
ECATIi].Error

ECAT]Ii].LinkUp
ECAT[i].LPDomainOutputState
ECAT[i].LPDomainState
ECAT[i].LPRxTime
ECAT[i].LPTxTime
ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/0O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable
(2 and 3 are not supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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10. Revision History

Revision Revised date Revised content
code
A July 1, 2016 First edition
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